
                          
Read Me

Digidesign TDM WaveDriver for Windows 2000

This Read Me provides documentation for the Digidesign TDM WaveDriver (Windows). 
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Introduction
The Digidesign WaveDriver is a two-channel, multimedia WaveDriver for Digidesign's TDM systems. This WaveDriver allows 
third-party audio applications to record and/or play through channels 1-2 of the first peripheral connected to your mas-
ter/core d24 or Mix card. It is compatible with Windows 2000 (Service Pack 1 and Service Pack 2).

Full-duplex recording and playback of 24- and 16-bit audio are supported at sample rates of 48000 Hz and 44100 Hz. Other 
word lengths and sample rates are available through the Microsoft Sound Mapper. 

Also included is the DigiGain volume control application. DigiGain allows control over the WaveDriver's master output vol-
ume and input/record monitoring levels. DigiGain has no effect on recording/playback in Pro Tools or any other application 
that communicates with Digidesign hardware via Digidesign's Direct I/O standard. 

Please note: The WaveDriver is not multi-client. Only one application can send audio through the WaveDriver at a time. You 
should generally try to minimize the number of audio applications you have running simultaneously and disable the win-
dows system sounds (as described later in this document). We recommend installing a separate sound card for third party 
soft-synths, games or multi-client audio work.
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Installing the WaveDriver
**IMPORTANT** Before installing the driver please make sure of the following:

Pro Tools hardware and software version 5.1.1 must be properly installed and functional prior to installing the Digidesign 
WaveDriver.

The WaveDriver shares several files with Pro Tools. These shared files are installed with Pro Tools version 5.1.1, not the 
WaveDriver. After installing Pro Tools, restart Windows 2000. Your audio interface also must be connected and turned on to 
successfully install the Digidesign WaveDriver.

Disable System sounds before installing the WaveDriver.

Digidesign recommends disabling all system sounds. Users may encounter problems when system sounds are associated with 
“Empty Recycle Bin,” “Select,” “Open Program,” and “Close Program” and other Windows events. In addition, disabling the 
“Windows Start” and “Exit Windows” sounds helps prevent possible speaker damage. The Digidesign WaveDrivers default to 
0dB when installed. Remember to turn down your monitoring levels before reboot after the WaveDrivers are installed. With 
the WaveDrivers set for 0dB, the 888|24 will output the system sounds at >110dB!

To disable system sounds:

1  From the Start menu, choose Settings > Control Panel > Sounds.

2  To disable all system sounds, under the “Scheme” pull-down menu select “No Sounds.” 

– or –

(To disable specific system sounds, scroll down the list of “Events” and select the one you want to disable such as “Start Win-
dows.” In the Name drop down list, select None.)

3  Click Apply, then OK. 

4  Restart Windows 2000.

Remove previously installed Digidesign WaveDrivers.

If you have previously installed an earlier version of the WaveDriver, you must completely remove it before installing this 
new driver. Please read the section entitled “Removing the WaveDriver” before proceeding.

Installation Instructions
1  First, launch the “DSI Setup.exe” (v5.1.1.68) file included with this new driver. Follow the on screen instructions.

2  Next, from the Start menu, choose Settings > Control Panel.

3  Click on “Add/Remove Hardware.”

4  Click on “Next.”

5  Select “Add/Troubleshoot a device.” Wait while Windows searches for devices.

6  Select “Add a new device” and click on “Next.”

7  Select “No, I want to select the hardware from a list” and click “Next.”

8  Select “Sound, video and game controllers” and click “Next.”

It is very important that the “DSI 
Setup.exe” (v5.1.1.68) is run first. If it was 
not run first, the WaveDriver will need to 
be removed and the Installation process 
reinitiated. If the WaveDriver needs to be 
removed please read the section entitled Re-
moving the WaveDriver.
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9  Click on “Have Disk...”

10  Browse to the location of the driver, select the “oemsetup.inf” file, and click “Ok.”

11  Click on “Next.”

12  If “Digital Signature” warning dialog appears, click “Yes.”

13  Click “Next.”

14  If message appears which states “The file'directio.dll' on Digidesign WaveDriver is needed.” Browse to the location of the 
driver, select the “directio.dll” file, and click on OK.

The Digidesign WaveDriver Settings dialog will automatically open. 

15  Click on the Advanced button to open the I/O Setup dialog. (See How to Change WaveDriver Settings below for more in-
formation about these dialogs.)

16  Click on the A: No Interface tab.

17  Select the Peripheral Type for the peripheral you have connected to your d24 or Mix card.

18  Make any other desired settings in the I/O Setup dialog.

19  Click OK to close the I/O Setup dialog.

20  Click OK to close the WaveDriver Settings dialog.

21  When prompted to restart Windows, please restart Windows.

File Specifics  

The WaveDriver consists of the following files:

In Windows\System32,

• Digi32.dll v. 1.7.1.68 cs7

• DirectIO.dll v5.1.1.68 cs7

• DSI.dll v. 5.1.1.68 cs7

• DigiUI.dll v. 5.1.1.68 cs7

The WaveDriver also relies on other files that were part of your Pro Tools 5.1.1 installation:

In Windows\System32,

◆ Mfc42.dll 4/23/99, v. 6.00.8447.0

◆ Msvcrt.dll 4/23/99, v. 6.00.8397.0

In Windows\System32\Drivers,

The WaveDriver may only be used with the 
first peripheral connected to your mas-
ter/core card. If your d24 / Mix card is con-
nected to two peripherals via a Y-cable, se-
lect the Peripheral Type for the peripheral 
connected to the “A” half of the Y-cable. If 
you have multiple Digidesign PCI cards 
connected to multiple peripherals, select the 
Peripheral type for the (“A”) peripheral con-
nected to your master/core card. Use the 
Identify checkbox in the I/O Setup dialog to 
verify which peripheral you are configuring 
for use with the WaveDriver.
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◆ Dalwdm.sys v. 5.1.1.66

In Digidesign\Utilities\DigiGain,

◆ DigiGain.exe v1.7.1.68 cs7

Removing the WaveDriver
1  From the Start menu, choose Settings > Control Panel.

2  Click on the “Add/Remove Hardware” Icon.

3  Click on “Next.”

4  Select “Uninstalled/Unplug a device” and click on “Next.”

5  Select “Uninstall a device” and click on “Next.”

6  Select “Digidesign WaveDriver” from the list and click on “Next.”

7  Select “Yes, I want to uninstall this device” and click on “Next.”

8  Click on “Finish.”

How to Change WaveDriver Settings
After installing the WaveDriver, you may access its settings as follows:

1  From the Start menu, choose Settings > Control Panel.

2  Click on the “System” icon.

3  Click on the “Hardware” tab.

4  Click on the “Device Manager...” button.

5  Expand the “sound, video, and game controllers” section.

6  Double click on the “Digidesign WaveDriver.”

7  Select the “Properties” tab.

8  Expand “Audio Devices.”

9  Double click on “Digidesign WaveDriver.”

10  In the Digidesign WaveDriver Properties dialog, click the Settings button.

11  You should now see the WaveDriver Settings Dialog (see below)

If you wish to return Pro Tools v5.1.1 to its 
original, pre-WaveDriver 2000, state you 
must completely uninstall Pro Tools v5.1.1 
via the “Add/Remove Software” control 
panel, then reinstall Pro Tools v5.1.1. See 
your Pro Tools Installation Guide for more 
information on this procedure.
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WaveDriver Settings Dialog

Note that you cannot access the WaveDriver Settings dialog under the following circumstances:

◆ When running Pro Tools and its Operations | Active in Background option is checked.

◆ When running Pro Tools and the Convert and Import dialog is open.

◆ When playing or recording in another audio application. 

◆ When using another audio application such as Acid or Cakewalk that has an option to keep the WaveDriver “open” even 
when you are not playing or recording. (You must close the audio application before you can open the WaveDriver Settings 
dialog.)

Buffer Size Control

When you play a file from a client audio application, the client app divides the file into little chunks (buffers) and sends each 
of these to the WaveDriver. The WaveDriver copies the client app's buffers to the d24/Mix's own buffers in a double-buffering 
scheme. The Buffer Size control in this dialog allows you to set the size of each of the two buffers the WaveDriver uses on the 
d24/Mix card. You may choose from the following buffer sizes:

• 128 samples (default)

• 256 samples

• 512 samples

• 1024 samples

Small buffers have the advantage of low latency in the record monitor path. (Latency is the time delay between a signal en-
tering the audio inputs and leaving the outputs during recording.) Larger buffers have the advantage of making the 
WaveDriver more immune to audio dropouts during playback/recording. In some audio applications, notably Sound Forge, 
performing various tasks such as maximizing or minimizing windows will interrupt the WaveDriver and create glitches in the 
audio. Choosing Medium or Large buffers can help alleviate this problem.

Pressing the OK button will cause settings to be saved in the registry when you shut down or reboot Windows. Pressing Can-
cel restores settings to what they were before this dialog was opened. The OK and Cancel buttons in this dialog have no effect 
on whether settings are saved or restored in the I/O Setup and Other Options dialogs described next.
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I/O Setup Dialog

Click the Advanced button in the WaveDriver Settings to open the I/O Setup dialog:

A: No Interface tab

Peripheral Type

Please choose the (“A”) peripheral you have connected to your master/core d24/Mix card.

Sample Rate

Available sample rates are 48000 Hz and 44100 Hz. You do not need to change the sample rate in this dialog before play-
ing/recording a file with a new sample rate. If you are playing a file, it will automatically play back at the correct sample rate. 
If you are recording a new file, simply choose the desired sample rate using the audio application's Preferences or Record Op-
tions dialog.

For information on playing or recording files at unsupported sample rates, see Known Issues, General, Unsupported Sample 
Rates and Word Lengths below.

Sync Mode 

Sync mode may be set to Internal or Digital and is Internal by default.

Digital Format

If your peripheral is an 888 | 24 or an 888, this control may be set to AES/EBU or S/PDIF and is AES/EBU by default. If your 
peripheral is an 882 | 20 or an 882, this control will be set to S/PDIF and will be grayed out.

Ch 1-2 (Format)

This control may be set to Analog or Digital. It determines whether the WaveDriver plays and records through your periph-
eral's analog or digital I/O. The WaveDriver can only play and record through channels 1-2 of your selected peripheral.

Identify Check Box

This control enables you to verify which peripheral you are configuring for use with the WaveDriver. Checking this box 
causes all the meters on the connected peripheral to light up.

Other Options Button and Recalibrate Button

The behavior of these buttons depends on the peripherals you have connected. Refer to the documentation for your specific 
peripherals.

Figure 1.  I/O Setup dialog
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B: No Interface tab

If you have two peripherals connected to your master/core card, you may select and configure the “B” peripheral using the 
controls under this tab. Note that these settings will only be relevant to Pro Tools - not the WaveDriver. See Installing the 
WaveDriver, Installation Instructions for more details.

Card Info tab

Bus, Slot Number

These controls display card specific PCI bus information and should not be altered.

Installing DigiGain
DigiGain is an optional volume control applet that allows you to control the master output of your Digidesign audio interface 
as well as control the monitoring input levels of the WaveDriver independently from your third party audio application. By 
default, the master level is set to 0 dB.

DigiGain is not available as a volume control on the Windows task bar. As a result, the following settings will be disabled in 
the Multimedia control panel (Audio tab). “Show volume control on the taskbar,” the playback volume control, and the re-
cording volume control will all be disabled.

Before installing DigiGain

The WaveDriver must be installed before installing DigiGain. If you did not install the WaveDriver or reboot the computer 
after installing the WaveDriver, do so now.

Installation Instructions

DigiGain.exe is installed to your computer’s Digidesign/Utilities/DigiGain folder via the “DSI Setup.exe” file included with 
the WaveDriver. 

Removing DigiGain
Using the “Add/Remove Programs” control panel select the “Digidesign DigiGain” listing and click the “Remove” button.
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How to Use DigiGain

Master Level

This slider adjusts the output volume of channels 1-2 on your Digidesign audio interface.

Master Mute

The master mute checkbox, when checked, mutes all output of channels 1-2 of your audio interface.

Record Monitor Level

These sliders adjust the output monitoring level of the left and right recording channels.

Record Monitor Mute

The Mute buttons under the Record Monitor Level sliders individually mute the left and right recording streams.

Gang

The Gang button groups the left and right Record Monitor Level sliders and Mute buttons.

OK Button

Clicking on the OK button saves the volume settings. Volume settings are stored in a registry key. This allows you to maintain 
the same volume level upon the next reboot or startup of the system.

Figure 2.  DigiGain WaveDriver Level Control

During recording, this does not affect the 
audio data being recorded.

As with the Master Level slider, these sliders 
do not affect the audio data being recorded.
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Known Issues:

General

Unsupported Sample Rates and Word Lengths

You may wish to play or record files at an unsupported sample rate and/or word length. Examples include files at resolutions 
of 16-bit/32 kHz, 8-bit/48 kHz, or 8-bit/22.05 kHz. To play or record files at an unsupported sample rate and/or word length, 
you must use the Microsoft Sound Mapper. 

To enable Sound Mapper,

1  From the Start menu, choose Settings > Control Panel.

2  Click on the “System” icon.

3  Click on the “Hardware” tab.

4  Click on the “Device Manager...” button.

5  Expand the “sound, video, and game controllers” section.

6  Double click on the “Digidesign WaveDriver.”

7  Select the “Properties” tab.

8  Expand “Audio Devices.”

9  Double click on “Digidesign WaveDriver.”

10  Make sure “Do not map through this device” is not checked. 

11  You may have to disable Sound Mapper for any other wavedrivers you have installed by checking this option for those de-
vices.

12  Next, launch your preferred audio application, go to its audio options menu, and select Sound Mapper as your audio de-
vice for playback and recording. You may see Sound Mapper referred to as “Wave Mapper” in some applications. Your system 
is now configured to record and play at sample rates/word lengths unsupported by the wavedriver.

However, if you often need to create files at an unsupported sample rate/word length, you will probably achieve the highest 
audio quality via another procedure. Select the Digidesign wavedriver as the audio device for recording in your audio appli-
cation. (Leave the Sound Mapper as your preferred playback device.) Record your audio at a higher sample rate/word length 
than your final desired rate/length. If your desired rate is 32 kHz, recording at 48 kHz is preferable to 44.1 kHz for the best 
quality. After your audio is recorded, use your audio application to convert the file to the desired sample rate/word length. 
In Sound Forge, go to the Process menu and select “Resample.” In CoolEdit Pro, go to the Edit menu and select “Adjust sample 
rate...” These sample rate conversion routines usually create audio files of higher quality than those recorded using Sound 
Mapper. Sound Mapper will still be required for playback -- but not recording and playback.

Window Operations

Clicking on the minimize, maximize, or restore buttons or pressing the right mouse button for an options menu may result 
in audible artifacts or stops during playback or recording. The recommended course of action is to avoid minimizing/maxi-
mizing during playback and recording. Increasing the buffer size in the WaveDriver Settings dialog may help alleviate these 
problems.
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Takes Too Many Steps To Change WaveDriver Settings

Try this to speed up your access to the wavedriver settings dialog. 

1  First, create a shortcut to the Multimedia control panel. Launching the Multimedia Control Panel from this shortcut saves 
3 mouse clicks. 

• Go to Start Menu > Settings > Control Panel. 

• Right-click on Multimedia and select “Create Shortcut.” A shortcut will automatically be created on your desktop. (You 
may copy this to your start menu too if you'd like.) 

2  Next, if you are often changing a wavedriver setting (i.e., sync mode) while working in an audio app, you can leave the Mul-
timedia Control Panel up rather than open it every time you need to access the wavedriver settings dialog. Leaving the Prop-
erties dialog open instead of navigating to it every time should save you 3 more mouse clicks to get into it and at least 2 to 
get out.

• Double-click on your Multimedia Control Panel shortcut.

• Click on the Hardware tab, in Audio Devices double-click on the “Digidesign WaveDriver.”

• Click on the “Properties” tab, expand “Audio Devices” and double-click on “Digidesign WaveDriver.”

• You should now see a dialog labeled “Digidesign WaveDriver Properties” with a Settings button on it. (Note, if you see 
the “Digidesign WaveDriver _Settings_” dialog, you went one dialog too far. Press OK to go back to the Properties dialog.) 

• Leave the Properties dialog open in the background while working in your audio app. 

• When you need to change a wavedriver setting, press the Settings button to launch the Settings dialog, change your set-
ting, and then OK out of the Settings dialog to return to the Properties dialog. You _must_ close the Settings dialog or 
you will not be able to play/record in other apps. (You also can't open the Settings dialog if you're already playing/re-
cording elsewhere.) 

Recommended System Settings

System Sounds

Digidesign recommends disabling all system sounds. Please see Installing the WaveDriver, Disable System sounds before in-
stalling the WaveDriver for instructions on how to disable system sounds.
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Known Issues with Common Audio Applications

Generally Applicable and Miscellany

Audio Application Freezes when Pro Tools is in the background

Description

• If you try to start an audio application when Pro Tools is running, the application will freeze up when playback is at-
tempted. 

Solution / Workaround

1  Make sure “Active in Background” is unchecked in Pro Tools.

2  Start the audio application you want to you use FIRST and then start Pro Tools. You should then be able to switch freely 
between applications. You may have to upgrade to Windows 2000 Service Pack 2 for this to work.

Audio Application cannot acquire hardware when Pro Tools is in the background

Description

• When switching between Pro Tools and another audio application, the system complains it cannot acquire audio hard-
ware.

Solution / Workaround

1  Make sure “Active in Background” is unchecked in Pro Tools.

2  On some systems there may be a considerable time lag between when Pro Tools releases the audio hardware and another 
application can acquire it. Try waiting a few seconds between minimizing Pro Tools and maximizing the other audio appli-
cations. Typically this wait time should only be a few seconds at most, but in rare cases it has been reported as large as 30 sec-
onds.

Real Time Audio Application has poor performance.

Description

• System audio latency performance is slow. This is most prevalent in real-time soft-synths such as Native Instruments Reak-
tor.

Solution / Workaround

• This is a design limitation of the WaveDriver. The best alternative with real-time soft-synths is to use a separate sound card 
that uses DirectSound or WDM drivers.

Audio has pops, lags, scratches, ring-modulation, or is otherwise “glitchy,” especially when playing a CD.

Description

• Audio playback has random pops, gaps or noises. Alternately you may hear a “ring-modulation” sounding effect; this is 
most common when trying to play a CD.

Solution / Workaround

• In the WaveDriver settings dialog, increase the buffer size.
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Cakewalk Pro Audio 8.0, 9.0

Recommended Settings

You may need to exit and restart Cakewalk in between making these changes to its audio setup.

CWPA 8.0:

1  Go to Tools | Audio Hardware. 

2  In the Audio Hardware dialog, select “Windows Sound Cards (DirectShow 5.1).” Do not select “Digidesign AudioMedia 3” 
or “Digidesign Session 8.”

3  Go to Tools | Audio Options. 

4  In the Audio Options dialog, select the Drivers tab. 

5  “Digidesign d24/Mix: Chan 1-2” should be enabled for both input and output drivers. 

6  Select the General tab.   

7  “Digidesign d24/Mix: Chan 1-2” should be set for the Playback and Record Timing Masters. 

8  Select the Advanced tab. 

9  “Enable Simultaneous Record/Playback” should be checked. “Use Wave Out Position for Timing” should be checked. 

10  “Use unpacked 32-bit storage for > 16-bit audio” should not be checked.

11  Set Wave queue buffers = 4 and Wave buffer size = 100KB. More buffers or a larger buffer size may allow you to have more 
tracks in your session. We get 8 tracks of 24-bit audio with this setting.

12  Press OK to close the dialog and save your settings.

CWPA 9.0:

1  If you are installing CWPA 9.0 after CWPA 8.0, we recommend removing 8.0 first rather than installing 9.0 over it. In our 
internal testing, installing 9.0 over 8.0 resulted in a maximum audio track count of 2 (!). If we uninstalled 8.0 before installing 
9.0, we could play as many as 8 24-bit tracks. We do not know the cause of this difference in performance but we do know 
that uninstalling 8.0 first fixed it.

2  Go to Options | Audio and select the Drivers tab.

3  “Digidesign d24/Mix: Chan 1-2” should be enabled for both input and output drivers. 

4  Select the General tab.   

5  “Digidesign d24/Mix: Chan 1-2” should be set for the Playback and Record Timing Masters. 

6  You will have to experiment with “[Number of] Buffers in Playback Queue” and “Buffer Size” to find the best settings for 
your system configuration.

7  Select the Advanced tab.

8  “Simultaneous Record/Playback” should be checked. 

9  “Stop On Driver Underrun” should be probably be checked. See Cakewalk help for more details.

10  “WavePipe(tm) Acceleration” should not be checked. Cakewalk's WavePipe technology is not compatible with the 
d24/Mix driver.

11  “Unpack >16 bit audio” should not be checked.

12  “Left-justify unpacked data” should not be checked.

13  Select the Device Profiles tab and select the “Digidesign d24/Mix: Chan 1-2” profile.

14  “Use Wave Out Position for Timing” should be checked. 

15  Press OK to close the dialog and save your settings.
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Cakewalk 8.0 hangs or crashes when you record enable an audio track (more likely) or press Play or Record (less likely)

Description

◆ Cakewalk may hang or crash if you record enable an audio track or press Play/Record in one of the following situations:

• (1) The WaveDriver Settings Dialog is open.

• (2) You are recording, record monitoring, or playing audio in another application.

• (3) When using another audio application such as Acid or Cubase VST that has an option to keep the WaveDriver “open” 
even when you are not playing or recording.

Solution / Workaround

◆ Before playing, recording, or record enabling in Cakewalk, 

• (1) Close the WaveDriver Settings Dialog.

• (2) Stop recording, record monitoring, or playing audio in all other applications.

• (3) You must either turn off the “always keep the WaveDriver open” setting in other apps or close the applications in 
which this setting is enabled.

Minor playback problems after recording

Description 

• If you have “Enable Simultaneous Record/Playback” checked, you might experience minor playback problems after a 
record pass. If you have recorded audio and have not moved the cursor, upon pressing play or record you may hear a snip-
pet of the audio you just recorded. Note that this is not a glitch in the recorded audio. 

Solution / Workaround 

• Move the cursor to a new location after each recording,

– or –

• Mute the record enabled track(s) until you are done recording. 

“Audio extension DLL cannot be found” error

Description 

• Upon launching Cakewalk, you see an error dialog saying “Audio extension DLL cannot be found.” 

Solution / Workaround 

• This error results from having “Digidesign AudioMedia 3” or “Digidesign Session 8” selected as your Audio Hardware in 
Cakewalk. 

• To change your audio hardware:

• Go to Tools | Audio Hardware in Cakewalk.   

• In the Audio Hardware dialog, select “Windows Sound Cards (DirectShow 5.1).” 

• Make sure the remainder of Cakewalk's settings are set to the recommended settings above. 
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Microsoft Windows

MCI Error when trying to play a file from within Explorer

Description

1  Select any wave file in Explorer.

2  Right-click on the wave file and select Properties in the option menu.

3  Select the “Preview” tab.

4  Click the “Play” button.

5  MCI Error: “All wave devices that can play files in the current format are in use. Wait until a wave device is free, and then 
try again.”

Solution

1  From the Start menu, choose Run.

2  Type “sysedit” (no quotes) and press OK.

3  In System.ini, type “waveaudio=mciwave.drv” (no quotes) under [MCI].

4  Save System.ini.

5  In Win.ini, type “waveaudio=mciwave.drv” (no quotes) under [MCI extensions].

6  Save Win.ini.

7  Exit from Sysedit and reboot system.

Real Networks RealPlayer G2

RealPlayer's volume and mute controls do not work

Workaround

• Use the DigiGain volume control application.

Sonic Foundry Acid

Recommended Settings

1  Go to Options | Preferences.

2  Select the Audio tab.

3  Make sure the default playback device is “Digidesign d24/Mix: Chan 1-2.” The default playback device is the first one avail-
able in a track's playback device selector list. (The “playback device selector” is that little number to the left of the mute but-
ton on each track.) If the d24/Mix is your default playback device, the playback device selector on each track should say “1.”

4  By default, you should disable (uncheck) “Keep audio devices open for faster playback startup response.” Disabling this al-
lows you to launch an audio editor such as Sound Forge from within Acid without encountering the dreaded “Error -6010: 
Cannot Acquire Hardware” errors. If you seldom use an external editor, or if you never use one at the same time as Acid, you 
may enable (check) this option for slightly faster response from the driver.

5  Set “Playback Buffering (seconds)” to greater than 0.07.

6  Press the Advanced button.

7  Select “Playback: Digidesign d24/Mix: Chan 1-2.”

8  You should not need to interpolate the WaveDriver's playback position.

9  Make sure “Do not pre-roll buffers before starting playback” is disabled.

10  Select “Record: Digidesign d24/Mix: Chan 1-2.”
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11  You should not need to interpolate the WaveDriver's recording position.

12  Press OK to close the dialog and save your settings.

Glitches during 24-bit playback/recording

Description

• The WaveDriver is compatible with almost all playback buffer sizes in Acid. However, some users may hear glitches in the 
audio if they are playing 24-bit audio with very low buffer sizes like 0.05 seconds or have many tracks in their session. In 
our tests, we get 6 or more 24-bit stereo tracks, and 10 or more 24-bit mono tracks in Acid 1.0.

Solutions / Workarounds

• Increasing Acid's buffer size to between 0.07 and 0.2 seconds often makes these glitches go away

• Go to Options | Preferences and select the General tab. Set “Play files from disk if bigger than (Megabytes)” as large as pos-
sible.

• Decrease the number of tracks in your session or record at 16-bit resolution.

Glitches while saving a track during playback/recording

Description

1  Go to the View menu and select Properties. (The Properties window will appear in the lower left corner by default.)

2  Play at least one track. 

3  During playback, select one of the audio tracks being played. 

4  In the Properties window, press the disk icon to save the track. 

5  One or both of these things will occur. Audible pops may occur. If so, they would appear in any tracks you are recording. 

6  If you are in loop playback, playback will stop (but the counter will continue) after the loop has played through one more 
time.

Solution / Workaround

• Stop playback in Acid before saving a track.

– or –

• If you must save while playing, increase the buffer size in the WaveDriver Settings dialog to help prevent the audible pops. 

Playback stops while generating Midi clock using the Opcode Studio 128X interface

Description

• Selecting “Generate MIDI clock” in the Option popup menu (or pressing Shift+F7) during playback stops playback. 

Solution / Workaround

• Stop playback in Acid before stopping or starting MIDI clock.   

Glitches while accessing a mounted HFS (Mac-formatted) disk drive

Description

1  Go to the View menu and select Explorer so you can browse your directories from within Acid.

2  Play at least one track. 

3  During playback, browse to an HFS volume in Acid's Explorer window and select it.

4  Audible pops may occur. 

Solution / Workaround

• Increase the buffer size in the WaveDriver Settings dialog to Medium or Large.
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Glitches and/or playback stopping when using Acid and Sound Forge together

Description

1  Play at least one track.

2  During playback, select one of the audio tracks being played and right-click on its track name. 

3  Select “Edit in Audio Editor.” By default the audio editor will be Sound Forge. 

4  You may hear clicks and pops while Sound Forge is launching. 

5  Begin playback within Sound Forge (while playing back in Acid). 

6  One or both of the following error messages will appear. 

7  The WaveDriver will display “Error -6010: Cannot Acquire Hardware.” Sound Forge will display an error dialog that says the 
WaveDriver is in use by another audio application. These dialogs are perfectly normal since the WaveDriver is indeed playing 
back audio in Acid. 

8  Press OK to close the dialog(s). 

9  Exit Sound Forge. 

10  In Acid, press Stop and then press Play again. 

11  In about two seconds, playback will stop even though the counter is still running. 

Solution

1  Press Stop again. 

2  Save your Acid session and Exit Acid. 

3  Launch Acid again and Open your session.   

4  Try playing back your session. 

5  If you don't hear anything or see another “Error -6010” dialog, Exit Acid again and Restart Windows. 

Workaround

• Stop playback in Acid before editing a file in Sound Forge or another audio application.

Error: Can't Play and Record at Different Word Lengths Simultaneously

Description

• You will see this error if you record at 24-bit when you are playing back 16-bit audio (or the reverse). The WaveDriver is not 
capable of simultaneously playing and recording at different word lengths. Recording will still commence, but you will not 
hear any audio already recorded.

Solution / Workaround

• Make sure the Playback Sample Size (Options | Preferences, Audio Tab) matches the Record Sample Size (accessible in the 
Record dialog after pressing the Record button).
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Sonic Foundry Sound Forge

Recommended Settings

1  Go to Options | Preferences.

2  Select the Wave tab.

3  Make sure the Playback and Record devices are set to “Digidesign d24/Mix: Chan 1-2.”

4  You should not need to interpolate the WaveDriver's playback or recording positions.

5  Playback and recording position biases should be OK if set to 0.

6  As a default, you may set “Total buffer size (kilobytes)” at its lowest setting, 64 kB. If you encounter any glitches in recorded 
audio, and the WaveDriver's buffer size is already set to Large, try increasing Sound Forge's total buffer size.

7  “Preload size (kilobytes)” may be set to 0 kB.

8  Press OK to close the dialog and save your settings.

Audible Pops after using an effects plug-in

Description

• You may hear a pop the first time a file is played after processing it with an effects plug-in. 

Solution / Workaround

• Increase the buffer size in the WaveDriver Settings dialog. 

Syntrillium Cool Edit Pro v1.2

Recommended Settings: General

1  Go to Options | Device Preferences.

2  Make sure “Digidesign d24/Mix: Chan 1-2” is enabled for both playback and recording devices.

3  Make sure “Limit Playback to 16-bit” is not enabled.

4  Go to Options | Settings, and press the Devices tab.

5  Make sure the Digidesign d24/Mix is selected as you Waveform Playback and Waveform Record device. 

6  Make sure “Limit Playback to...” is not enabled for 16-bit or 8-bit or mono.

7  Press the Multitrack tab.

8  Make sure Open Order and Start Order are set to Play, Rec.

9  We have had good results with these buffer settings: Playback Buffer Size = 2 sec, Playback Buffers = 10, Recording Buffer 
Size = 2.7 sec, Recording Buffers = 4, (optional) Background Mixing Priority = 2. 

10  Press the System tab.

11  Make sure “Send 24-bit Using 3-byte Packed Format” is enabled.

Additional Recommended Settings: 16-bit Playback/Recording

1  Create a new multitrack session that is 16-bit, not 32-bit. Go to File | New, select your sample rate and “16-bit” as your Res-
olution.

2  Go to Options | Settings, and press the Multitrack tab.

3  Make sure Default Rec is set to 16-bit.

4  Before record enabling a track, click on the Record Device button next to it (a small button with a red number on it). 

5  Make sure your Record Device is set to the d24/Mix and 16-bit. Press OK to close the Record Device dialog.
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6  If you wish, you may save your blank session now and use it as a 16-bit template. Just make sure when you open it that all 
tracks have their Record Devices set to 16-bit.

Additional Recommended Settings: 24-bit Playback/Recording

These instructions are basically the opposite of the 16-bit settings above.

1  Create a new multitrack session that is 32-bit, not 16-bit. Go to File | New, select your sample rate and “32-bit (float)” as your 
Resolution.

2  Go to Options | Settings, and press the Multitrack tab.

3  Make sure Default Rec is set to 32-bit.

4  Recommended: Set Playback Mixing and Mixdowns to 32-bit.

5  Before record enabling a track, click on the Record Device button next to it (a small button with a red number on it). 

6  Make sure your Record Device is set to the d24/Mix and 32-bit. Press OK to close the Record Device dialog.

7  If you wish, you may save your blank session now and use it as a 24-bit template. Just make sure when you open it that all 
tracks have their Record Devices set to 32-bit.

Error: Can't Play and Record at Different Word Lengths Simultaneously

Description

• If you try to record in Multitrack View with one of several sets of settings in Cool Edit Pro, you may see this error. The 
WaveDriver is not capable of simultaneously playing and recording at different word lengths. Recording may or may not 
start as a result.

Solution / Workaround

• Make sure that you have configured Cool Edit Pro using the general recommended settings AND those settings for the spe-
cific word length (16-bit or 24-bit) you are using.

Winamp

DigiGain must be re-initialized for each song in a WinAmp playlist.

Description

1  Set DigiGain to -Inf press ok.

2  Song cannot be heard.

3  Open DigiGain, it's still at –Inf.

4  Wait until the second song on the playlist begins.

5  Note the volume can now be heard.

6  Open DigiGain and note that it's on 0 db again.

Solution

1  Right-click on the title bar in winamp. Select Options > Preferences... Alternately you can just hit Ctrl-P.

2  In the left hand window of the winamp settings dialog select Plug-ins > Output.

3  In the right hand window of the winamp settings dialog select “Nullsoft waveOut plug-in” and click on “Configure.”

4  Under “Volume Control” on the bottom make sure “Enable” is not checked.
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